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Chapter 1. Getting Started 

Introduction 

This book will concentrate on the modeling application used to create solid models of parts, 
engineering design and drawings, and assemblies. 

The tutorials in this book assume you are using the default settings of SOLIDWORKS in 
a university setting. 

SOLIDWORKS uses the mouse and its three buttons extensively. Therefore, it is essential 
to understand the mouse button’s basic functions listed below. 

 
LMB—(LEFT MOUSE BUTTON) 
 
Used for most operations such as selecting icons, picking graphic entities, and selecting 
menu items. 
 
MMB—(MIDDLE MOUSE WHEEL) 

Used to maneuver the entities in the window. To Rotate hold down the wheel button then 
move the mouse. To Pan hold down the wheel button along with the <Ctrl> key and move 
the mouse. To Zoom hold down the wheel button along with the <Shift> key and move the 
mouse. Spinning the wheel causes the entities to zoom in or out relative to the position of 
the mouse cursor. 
        
RMB—(RIGHT MOUSE BUTTON)  

Hold down the button to bring up additional available options in a context-sensitive pop-
up menu. 

The <Esc> key is used to cancel a command. Sometimes it may be necessary to press the 
<Esc> key twice to cancel a command. 
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The <F> key resizes the entities in the window to fit in the window. Entities typically go 
off-screen when they are being resized or moved. 

The <G> key activates the magnifying glass feature so you can zoom in on an area. 

<Z> key and Shift+<Z> key 

Pressing the <Z> key zooms out. Holding down the <Shift> key and pressing the <Z> key 
zooms in. 

Using just the Arrow keys 

 
Pressing the arrow key rotates the entities on the screen left, up, down, or right. 

Holding down the <Shift> key and pressing the arrow keys rotate the entities on the screen 
90 degrees left, up, down, or right. 

Holding down the <Alt> key and pressing the left arrow key rotates the entities 
counterclockwise. <Alt> key and right arrow key rotate the entities clockwise and normal 
to the screen. 

Below is a list of other keystrokes used in SOLIDWORKS and their meaning. 

<Ctrl> + <1>  makes the Front View normal to the screen 
<Ctrl> + <2>  makes the Back View normal to the screen 
<Ctrl> + <3>  makes the Left View normal to the screen 
<Ctrl> + <4>  makes the Right View normal to the screen 
<Ctrl> + <5>  makes the Top View normal to the screen 
<Ctrl> + <6>  makes the Bottom View normal to the screen 
<Ctrl> + <7>  makes the Isometric View normal to the screen 
<Ctrl> + <8>  makes the current selected surface normal to the screen 

 

Note: It is good practice to create a SolidWorks Templates folder to store your templates 
in and a SolidWorks Parts folder to store your data files in before starting 
SOLIDWORKS. When saving files in SOLIDWORKS, you should always verify that you 
are saving them in the proper folder before picking the Save or Save As button. 

When working with SOLIDWORKS, it is strongly advised to save your work often in case 
of a power failure or an unexpected program crash. 
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Note that SOLIDWORKS 2025 is backward compatible with 
only SOLIDWORKS 2024 and 2023. SOLIDWORKS 2024 is 
still backward compatible with SOLIDWORKS 2023 and 2022. 
1. Before starting SOLIDWORKS, create a SolidWorks Part folder and a SolidWorks 

Templates folder on the desktop. 

2.  Double-click the left mouse button (LMB) on the SOLIDWORKS 2025 
icon on the desktop to start SOLIDWORKS. 

3. If SOLIDWORKS is in Novice mode, the following screen will appear. 

 
4. Pick the Part icon, then pick the OK button. The following screen will appear. Right-

click in the menu area above the tabs to bring up a pop-down menu. Check the Use 
Large Buttons with Text option. 
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5.  Pick the Options icon at the top of the window. When the System Options 
window appears, pick Colors. Then select Viewport Background in the Color 
Scheme settings area. Pick the Edit button, then select White from the color menu. 
Check the Plain (Viewport Background color above) option in the Background 
appearance area. Pick the OK button. This will produce a white background while 
you are in SOLIDWORKS, which is my preferred background color. 

6. Change the Top Gradient Color and the Bottom Gradient Color to white as well. 
Pick OK. 

 
7. In the lower right corner of the screen, pick the unit's area (either IPS or MMGS), 

then pick Edit Document Units… Most of the exercises in this textbook use the IPS 
system so make sure IPS is selected. 
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8.  Pick the Options icon at the top of the window again. Pick the Document 
Properties tab. Set Overall Drafting Standard to ANSI and Length Units to 3-
decimal places for inches, then pick OK. 

 

 

9.  Under File at the top of the screen, pick Save As… 
10. For the Save As type: select “Part Template (*.prtdot) from the pulldown menu. 

Enter “Part_IPS_ANSI” as the filename. At the top of the window navigate to the 
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SolidWorks Templates folder you created previously, and pick the Save button. 
If a file called “Part.PRTDOT” is in the same directory, you can delete it. 

 
11. Under File, pick Close. 

 
Now we need to add this folder to file locations that SOLIDWORKS can look into. 
 

12. Under the Tools menu, pick Options. Select File Locations under System Options. 
Make sure Document Templates is selected as the Show folders for: option. Pick 
the Add… button to add the user-define template to the list of folders containing 
document templates. Locate the SolidWorks Templates folder on the Desktop, then 
pick the Select Folder button. 

 
13. Pick the OK button. If a pop-up window appears with the question, “Would you 

like to make the following changes to your search paths?” Pick Yes. 
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We will use this template for each new part we create so that we don’t have to set these 
parameters each time we create a new part. 
 

14. Under File, pick New… Pick the Advanced button in the lower-left corner of the 
window if SOLIDWORKS comes up in Novice mode. 

 
15. Under the SolidWorks Templates tab, pick the Part_IPS_ANSI icon. Pick OK. 
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We are back in SOLIDWORKS with all desired parameters already set. If the left 
Extruded Boss/Base Toolbar and the right Sketching Toolbar are not present, don’t 
worry they will be added shortly. 

 
Note that I only have 3 tabs (Features, Sketch, and MBD Dimensions) listed in my working 
window because I have turned off the other tabs. You may see more tabs. Right-click at 
the top and select the Tab option to turn off the tabs you do not want to see or use. 
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With Use Large Buttons with Text selected, the three tabs appear as follows.  

The Sketch tab. 

 
The Features tab. 

 
The MBD Dimensions tab. 

 
You can also add the Sketch and Features tools along the side of the window. The Sketch 
tools will appear along the right side of the window. The Feature tools will appear along 
the left side of the window. These are added using Toolbars from the same pop-up menu. 
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Selecting the CommandManager from the pop-up menu disables it. Picking it again 
enables it. Disabling the Use Large Buttons with Text option gives you more room to 
work so do this now. 

16.  To start a sketch, first select one of the three principal planes (Front Plane, 
Top Plane, or Right Plane) in the Feature Manager Design Tree, then pick the 
Sketch icon at the top of the window or along the right side of the window using 
the LMB. Pick the Front Plane for this exercise. 

If you forget to pick the plane first, the three orthogonal planes are listed in the Feature 
Manager Design Tree so you can select the desired plane such as the Front Plane. 

Before sketching it is a good idea to turn on View Sketch Relations so you can tell when 
a line is horizontal, vertical, parallel to another line, perpendicular to another line, tangent 
to a curve, etc.  

17.  Pick the eyeball icon in the View Heads Up Toolbar.  Verify that the 
View Sketch Relations icon is highlighted, otherwise select it. 
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18.  Select the Line tool, then draw a few lines similar to what is shown below. 
The exact locations or lengths of the lines don’t matter. Typically, you want to start 
at the plane’s origin. If you create a closed area, the area will be shaded as shown 
below and the line command will be paused for one mouse click. To stop a chain 
of connected lines, double-click the left mouse button (LMB). The line command 
is still active so you can continue to draw additional lines. To stop drawing lines, 
press the <ESC> key, or Right-click (RMB) and pick Select from the pop-up menu. 
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If the sketch relations do not show up on your sketch, see step 17. 

In the figure above, the Coincident Sketch Relations icon indicates that the first point 
is coincident with the Front Plane’s origin. There are two sets of parallel lines. There 
is a vertical and a horizontal line, and two lines that are perpendicular to each other. On 
the right, one line connects at the midpoint of another line and is coincident with that 
line. This information can be very helpful when sketching a given shape. A list of 
Sketch Relations is shown below. 

  
If your sketched lines do not reflect the desired Sketch Relations, you can select the 
appropriate lines by picking the first line, then holding down the <CTRL> key and 
picking the second line. A list of possible sketch relations will appear on the left side 
of the window. Pick the appropriate sketch relation from the list. 

19. Move to the upper portion of the sketching window and hold the LMB down. Use 
a sweeping motion to surround all of the lines previously drawn. Release the LMB, 
then press the <Delete> key to delete all of the selected lines. 

20.  Select the Circle icon from the sketch toolbar. Pick a point in the window, 
then move the mouse to a new location. A Circle’s center will be located at the first 
point selected and the size will be dictated by the second mouse pick. Draw several 
circles similar to what is shown below. 

21. Pick the center of the circle at the origin, hold down the <Ctrl> key, and pick the 
center of the smaller circle below it. In the Add Relations window, pick the Vertical 
icon. Pick the green checkmark. 

22. Pick the center of the left circle, then hold down the <Ctrl> key, and pick the center 
of the right circle. In the Add Relations window, pick the Horizontal icon. Pick the 
green checkmark. 

23. Pick the edge of the left circle, then hold down the <Ctrl> key, and pick the edge 
of the right circle. In the Add Relations window, pick the Equal icon. Pick the green 
checkmark. 

24. Pick the edge of the left circle, then hold down the <Ctrl> key, and pick the edge 
of the circle centered at the origin. In the Add Relations window, pick the Tangent 
icon. Pick the green checkmark. 
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The first circle was drawn at the origin of the sketch window. The smaller circle is 
directly below the first circle as indicated by the Vertical relation. The left and right 
circles are equal in size and their centers are along the same horizontal axes. 

25. Select the Line tool again, then add four lines that are tangent to the four circles as 
shown. If any of the lines are not tangent to the given circle, select the circle near 
the endpoint of the line, and pick Tangent from the Sketch Relations window on 
the left. If another relation is present other than the coincident relation at the end of 
a given line, pick the relation with the LMB, then press the <Delete> key to remove 
it. Each line segment should have a Tangent and Coincident relation attached. See 
the figure below. 

 
Use the Trim Entities tool to remove unwanted portions of your sketch. 

26.  Select the Trim Entities icon. Move the mouse inside the four tangent lines, 
then press down and hold the LMB, and drag the mouse cursor around without 
touching any of the four lines or the outside region of the four circles. Your sketch 
should look similar to the figure below. If you accidentally touch a line or the outer 
portion of a circle, undo the changes by pressing <Ctrl>+Z and try again. 
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At the bottom of the window, the phrase Under Defined is visible. This is because we 
haven’t sized any of the circles or located the centers of any of the circles. We will do 
this now. Also, note that the sketch is not currently symmetrical. 

27.  Pick the Smart Dimension icon. Pick the left circle, then move away from it 
and pick the location for the size dimension. Type 1.5 for the value, then press the 
<Enter> key or pick the green checkmark in the pop-up window. 

         
The radius of the left arc will be resized to 1.50 inches. Note that the right arc will also 
be 1.50 inches since the two arcs were set equal in size previously. Note that the 
dimension names will show up as well if the View Dimension Names is turned on.  

28. Pick the top arc and set its size to 1.75 inches. 
29. Pick the bottom arc and set its size to 1.00 inches. 
30. Pick the center of the left arc, then the center of the right arc. Move the mouse 

cursor down and note that a dimension appears between the centers of the two arcs. 
Set its value to 5.50 inches. 

31. Set the distance between the top arc’s center and the bottom arc’s center equal to 
3.00 inches. Dimension the distance between the top arc’s center and the left or 
right arc’s center. It should be a driven dimension equal to 1.73 inches. 

At the bottom of the window, the phrase Under Defined is still showing so there is at 
least one more dimension or sketch relation missing. Let’s make the object 
symmetrical. To do this, we need to add a centerline, and then add a symmetric relation. 
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32.  Pick the down arrow to the right of the Line 
icon to bring up a pop-up menu. Pick Centerline 
from this menu, then draw a vertical centerline 
through the origin. 

33. Pick the center of the left arc. Hold down the <Ctrl> key and pick the center of the 
right arc, then pick the centerline. Select Symmetric from the Add Relation 
window. (You can pick these three entities in any order.) 

At the bottom of the window, the phrase Fully Defined appears, and your sketch should 
look exactly like the sketch below if the View Dimension Names option in the 
Hide/Show Items feature is turned on. (See page 1-11.) 

 
Let’s exit from the sketch, and extrude this shape to make our first 3D part with a depth 
of 2.00 inches. 

34.  Pick the shaded Sketch icon on the right or the Exit Sketch icon at the top of 
the screen if the Use Large Buttons with Text feature is enabled. 

35.  With the sketch highlighted in the Feature Manager Design Tree, pick the 
Extruded Boss/Base icon. Leave the direction as Blind. Set the depth in Direction 
1 to 2.00 inches. Pick the green checkmark to complete the extrusion. 
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The final extruded part appears on the screen. 

 
36. If necessary, press the <F> key to fit the part on the screen. 
37. Right-click on the Material icon in the FeatureManager Design Tree and select 

Plain Carbon Steel using the LMB. Notice that the selected material now appears 
in the FeatureManager Design Tree. 
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38. Under the File menu, pick Save. Name the part as “First Part”. Make sure you are 

saving the part file in the SolidWorks Parts folder you created previously. Pick 
Save. 

39. Under Tools, select Evaluate, then select Mass properties... The following 
window appears. The mass should be 18.88 pounds and the volume should be 67.01 
cubic inches if you properly dimensioned the part and added the appropriate sketch 
relations. If not, go back and check your construction procedure. 
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40. Pick the X in the upper right corner of the window to close the Mass Properties 
window. 

 
41. If your mass or volume is different, right-click on Boss-Extrude1 and select Edit 

Sketch, then check over your sketch for this part. Maybe you are missing a sketch 
relation. After correcting your sketch, exit your sketch, and check Mass 
properties... again. 

 

42.  Pick Save. 
43. Under the File menu again, pick Close. 
44. Under the File menu, pick Exit to exit from SOLIDWORKS. 
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